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B B :oEL COo, DFELEFMAD A F T L DI DEFIC

VOV OMENNIRED H N2 0o 72703,

BESCIRIERECRESFRICHML 2. 72,

- JAEE?

GRBEEEFMLZ. W EEO

SUCHIE, MLERC X

DM EES, REE SERICET L, MBHLZCO, IS, MEIZ O L T 5 2 LAURENze.

HH o CO, i % 600 wmol mol ' IZHERE L 7225, 2 DR AHEETRIRIZIL 51% 128 L F o7z RFEH
A BRFERIE, S BIZRIERO B\ CO, MMERFEIZ M 721815 & %2 2 TRt R Sz,
F—T— K MURIEE, CO, MM, HIRFEAMRL, RFEHE, W

Increase of root dry weight of strawberry by simultaneous application of cool air and CO, and evaluation using
carbon stable isotope ratio : Akimasa Nakano", Chizuru OHrawa?, Shie Kuropa® and Teppei KawaGucHT”
("Chiba University Graduate School of Horticulture, "YANMAR GREEN SYSTEM CO., LTD.)

Abstract : Effects of simultaneous application of cool air and CO, were evaluated on initial growth of strawberry
(‘Yotsuboshi’). However, these treatments did not increase shoot dry weight, the root fresh and dry weight were
increased. Natural abundance of ’C of both parts are decreased significantly by the treatment, these results
suggested that applied CO, was absorbed and translocated to the root. Even though CO, concentration has
been maintained around 600 pmol mol ' in the day time, CO, use efficiency evaluated by '’C natural

abundance was estimated only 51%. Natural abundance of "’C could be an indicator for developing more

efficient CO, application method.

Keywords : Carbon content, Cool air, CO, application, Natural abundance, Root development.
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XZHE COy X & L, T &9 UELD D 72 WL
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2. JLEIITILEVRY MEICKBBRRDOEILER
i
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WEHEEL L BOoNRo—#%2 55 a1
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IRMS) |2 & 1) jmFHHEL X ORFLERNMARL % )
E L7z SUCEDEHIZOWTIE, §°C-PDB (Pee Dee
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H 1 HREB T/R It
FW (g) DW (g) #W™% TFW (g DW (g) #i= (DW)
PO 21.5 4.78 0.222 8.3 0.82 0.098 5.8
@ CO,  20.8 4.93 0.235 11.8 1.23 0.104 4.1
T-test? ns ns ns * * * *

Z:5%DfEHMFETHEEDY (%), %L (ns).

D3, 8C = R sample/R standard— 1 (R sample : 20
PC/®C1H, R standard @ FROEEHEYIEOME) 12X )&
L7z, HA7id% OS—3)V) ThHb. LB O
IZOWTIE, B A = A () IIKEEL TERG L
7z.

N

LS

1. HEBMS LU THOREFHLES
WEEAR O F B OB % 5 2 KIZRT. CO, |
DV T E R DL LR IR X T 469 + 30 wmol mol ™' 12
xt L C, %JE CO, X Tld 617 = 60 umol mol ' Td - 7.
IO L Z NN, AR T 451 £ 21 umol mol
12xF LT, #JaL CO, X Tld 446 *+ 20 wmol mol ' 1272 o
Tz, WDV, RHEIX T 252+ 4.3C 12kt
LT, %WHECO,XTix213x33CLA->THEY, &
B oWTE, HESNERDMER TE Tz,
A F IO FEHOFEEE, ZWE, ZHFEIZOWT
(&, AREEESME IS EE CO, D FIFLE ORI
Do hhol BB1F). —HT, BIZowTiE, 4

i JE, CO, MLBEAS A F T DOMLR

53 1252 %58
BELERDPRROONz (3 X)), WEOHEE, w7

WE, EWFEIZOWTEIWTROGEE CO, DI KL
HOREBO N (B 13), TN 1415 151,
1065127 72, ZD72D T/R b ABEREDTED H,
KRS58 I L TALIIKT L7z, BRdH72) ok
XSRS CO, DRI X ) 165125 & DI,
MOFEEIZOWTHHELFEHIBO SN (552
). TbHHBOFIYEEA 0.365 mm (28 L TR
FEIX TIZ 0.330 mm EAIVIR E 7o T 7z R EIC

— 55 —
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2R B CO, WMELA A F TOMWRRIZG 2 5 5%
Bdb7z)RE HRE FHER
(m/#) (m/g)  (mm)

o 73.2 90.16  0.365
#E CO, 119.7 103.56  0.330
T-test” % ns %

Z: 5% DfEERTHEADY (%), &L (ns).

33K W CO, WA A F T IRFFMARL, RFEEHE,
WP ARIZ G- 2 B 5522

[ A4 HE 2
WA (%)

WA MR e sERvA

5C (%) C (mg/gDW)

o BE AR

pogi -30.6 —30.7 411 402 0 0
W CO, —33.0 -326 414 382 51 12
T-test” * % ns *

Z:5%DfEMETHEEEDY (%), %L (ns).

DWTIHBENRD N h o7z,

2. i EERE K UIRERD iR R LLIALE
FFEEHRICONWTIE, I EETIZPEX | X 22
B LN, WRETIIAERIET L. T4abb
PG A HRILAT X 402 mg/g DW 1% L C, MLELX
T382mg/gDW Il Y, HEIZ5%IT L Twi.
SPCIEIZH EH B X ORI CTHBEIK T LA (53
). ZOETIZHEZRT 2.4%, TRET 1.9% TH - 7.

BE

1. REEDH-EMEETOARR CO, NIEDFHE

AREBIZBWTIE, $AE CO, WH DM _EFA~DORF
NROOLNL o720 T, W EHOARTEIMET S &1
K ARET, FMEBORE, W CO, ALHR)A
% AL WREMAE 2 bz, KPITOTF—F12L 5
&, 2020 FF D 7 B3 ER A &, FAEME (1981 ~
2010 4F) @ 153 BER 2% L C, 2020 4F 7 B 1% 61 e
Thot:. H EIBOAFIEHE CO, WHRDOEEAZLD
BN o7zZ EIXHED T &b R L 7T HE
W 57-0, Wi Z 2 TN 52 LEDNDH 525
REBRWIH OBBESM T, MIRIIZ b ERBDFSEDS
s, REOIEIME SN EZ BN D, B
CO, LHIZ X ) #kdy 72 ) OMOFEW T L 7228
(1K), REGEFRIMET LA B3K). JiudiE
BT 72 E OISR CO, IR L 1) T L T B
RN A RTH M TH ) SHBFONEICONT
ST A ENH S, T2 D LD BIROEL)E R
BOWNEOWINIFG T HHEED H 1, REHO3EE
BB O FEROEE B X O & OREIZOWT

AT B UEND 5.

2. WA LT= CO, DIRILE & RUNhER

(1) A L 1= CO, DRINE

FERE, 14 ACTEMBGICHA L7 COo, & (AKX
PO OMFEER) EEREA, S, 1T HN2D 1ERICHIH
L72CO, D&l 99g THo7z. AKERT AT LTH
ot v HEAD CO, #E % 600 wumol mol ' HifA A
F3o12d, CORPUETH /20w ) T EIlhb.
B1EBIVEIEROHERLS, 1H1HESZDICHE
ESINT CO, DmAHEET H EAIEA 0273 g 123 L
T CO, % JHALEL T 0300g & 7 1), ALHX D1
0.0270g L 2o 7. DF W HEHED 03% L2 S
TWRWEERE o7z, SRIOMPIIFERRTIID 225,
HEEBS TS 2G5 WEO S s S 5. 05
M OEERILNE N O CO, it ORIF A - L 72b DT
Y, DHEHNIHE L725E L BT E 2wvs, 2
DEH 7 CO, v AT AIZB VT, ShHiEo COo, fii
ORI EE 2 5D,
AFT1IERL BB 720 OARPITD CO, WIE % 5
L7=WF2Eic BT (IES, 2015), S HEOSEMIZHRD
W& BH S 700 wmol mol ' IXTIE, 1.1 g/Mk/H &
ENTWD, ZORFRIGPENORITH Y, FEHH
g, SRofEtch, Bk s 2 LiIdHES
N570, SHOKS 03 g/fk/HLBUK» 5% 2T
TBLAERTHL EEDbNG,

(2) #ER L1z CO, MOFAzhE & RALIALLE A O aTEEME
HERR OB A M L 72 CO, OFIHFIL 51.6
~56% & EH SN T2 (Kuroyanagi et al,, 2014). =
IO - 7ZBEIZBWTH, e EH Y, F)
MR COREICR DL ZEERLTWS. ZOGEER
fiH L7z CO, ASENTETREMICEE S Mz h %R LT
W5, SOFERBSRITEYTH 0 EHMEAMR IR T
HY, TOX) BRI TA F ITOREBOFHLILH
(7:00 ~ 17:00) (2B\T, 600 umol mol ' IZHERF X 1
TWizbEZONL, TOX D) RlHE 0L EREIZE
VIRRET, SRIEH L 72 Wik BEREAE I BT,
L7 CO, D LI I N T x kRRLE
FRARIE 2 SHEES B 2 & 2l

9, WHEXOFHDIIOWT, CO, L §°C1H
WZOWTHRET 5. BH O KK D CO, D sCHIZ
—11%RETH S LHEESND OB, 2009). AR
¥ ND CO, D SC DIEIZ—24 ~—-38%TH LA, 4
HFEML7-E A -302%CTHo720T, ZOfE%H
M35, £/, SROEBRER BE2H) »5, KA
CO, 1& 469 umol mol " (K IRIX D FH4fl), CO, ML=
L% ks (BH O CO, HEDOXIRIX & D25 D1y
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fiti) % 148 umol mol ' & HIE L 72855, H ARV D
SBC DEAT—302% Tdh - 72D T, INE PG TEHET
5L, REBEDIPLX TIL °C 23—15.6% D CO, H*H
H(7:00 ~ 17:00) OFFAR THo/z L HEE SNz, Z
g, SRR L RS EIRE TR, %
B2ROLOGROMEMLIZ2 ~4m/s THY), AR

YRPB O CO, 72T ThR L ENKKAD CO, DEE%
B ZITLRBIZHLZENHLID LX) BRIREE L
7z,

WIZA F T (KEIE) O SSCEIZOVWTTH D, C,
FEW D 5BC 1L —28% F2E TH 2 2% (85, 2009),
LD A F TORIED §C il & H B35 & ROz
EAHWTNEFREET 5 L -306% 05 BE 525175
ToSCHEFE SN ZokE KRADH
(—11%) & DL 196% & 72 5. 2D 19.6% DIED
A F IO L DIl L THE LTS &K
ET DL, KEAO&EWRINL 721K 1E -306% (=
-11-196) 12k &2 6N 5. L, FEFM
RIitpoHEE SN D, HENIZR » XEHEROTEH CO,
WNEODOWEDMETH L. SHEMEINIEEZ LN
RO, D F ) KD 469 umol mol ' 12K N
? 148 umol mol ' DEIE TIRA S N7z LARGE L 7254k
DCO,NZDEFAF TN E N E T 5 & 55C
fifild —35.2% (—15.6—-196) (2% b EEZLNL. 2
g, BEERAYICR Y NERO CO, AR DR ESRIET
& % 600 umol mol ' F TEN S NTZI%E 1009%WIL
LB aDETHL. ZoXunrs 100 F TORER,
PSR FRARD SHERE L 7-h L v ) 2 LT, K
TR AAHEE IR & 5 5

HH CO, XD FALAHE RPN % Lt &9 2E
KRR CHEET B L B1% & o7z, D% W AEWIESE
A% A 600 umol mol ' FEFEIZHMERF S 2 720, izl
TE o 300 fEAEEE O KEFE O CO, % il L7238 Th,
FiH L7z CO, VHE S NA L )TN E T
o 2RSSR E Nz T2, ZofEIE KARD
469 pmol mol ' 12K > X 148 umol mol ' DEE TR
BENTEMRENRAS>TWDLDT, K ROHTADE
HEG 3 2 AULTRPHE D §°C fiE1E — 15.6% 75 & &
WKL A 2 LB HESNS. 20 L) LEE1218,
FRAAHEE IR 55 2 L1 ), &mR
NH 5D CO, DL STz & F B & FARIEER IS
IF12% 2% D, ZFD720, SRS N7z AR HE
SEWLIURN 2 51% &\ ) fEIZ 4 O F T O R KAE 2
(EE s

M L7z CO, 23 & ) KEDEISE DWW 2RI DWW
TERETLE, 7, HHOEENEZ SN RE
B Cld CO, Dt OF%EIX 7:00 ~ 17:00 TH O H A

HozBoTNpEO SN 7H 15 HOT3EH
TOHOHMBITHD A ORZIL 4:35 1 X U8 18:55
Th), CO, ML TE B H -7 &Ik
5. TOHMIZKED CO, DAZWILL TWDHDT,
i CO, DR E RN % TP BJHKH & 72> T
WwiokEZzohs, MM oL HEEICHT S 7:00
~17:00 DFEF A SR DX 093 TH Y, 78~k
FEBE O AR E RIS O T, R IR % &b
5L THMETELWEEEDLEH L. ZOENIZD,
YD D RS TUE 600 wmol mol ' 127k o TV 7z
B, BEEMNIZ CO, AT EE- TV ho sz, U HiED
ST OVERE X0 AR B OIRFEDE D > 72T HEME D B
b, FD XS KH CO, DA — A EAARIEE I
WA TR H 5.

DLb#ERD S, AR IR 2R OB 2 [ T
X, OHFHZEDET CO, i (BEHS) EA
T52L, @trTofiEr L) MWRISEOTTE
HIsIE, @CO, DL DHENIZASL LI IZHER
WEET LI, hEORENEZONT. T2 2
NSDOWFIZL Y, FEBIHEWR O FALARHEE I
Ham L&D T LSRR O % MR LTk &
L CHEN. T B BN D 5.
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DIEZIZOWTHA L, BEOHIEOEIZOWTER L2, WARKLEEFHGE &I, ROMRIG AT
52 OMNESEIIIEINT 575, WKLBLANESE Y 2 IR ORI EABIE S 2 2 A 7%\ I2 b 2
PH 5T, SRR 1D L THIRIX E DRI R Rofz, HEOREIMAKENKREC, B X
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Relationship between root activity and carbohydrate distribution between scion and rootstock in grafted mango
trees under flooding : Akira SAEki and Naoto Iwasaki” (Graduate School of Agriculture, Meiji University)

Abstract : Grafted mango trees tend to die when the graft union is submerged in water. In this study, we
investigated the root vigor using triphenyl tetrazolium chloride (TTC) reduction tests in relation to
carbohydrate distribution and defoliation, when the trees were submerged up to 5 cm above the graft union.
Immediately after the commencement of flooding treatment, the root sugar content increased due to the
decrease in the root vigor. Although the root vigor did not recover during flooding treatment, the root sugar
content gradually decreased to a level not significantly different from that in the non-treated control.
Defoliation in flooding trees varied greatly and was correlated with the sugar content of the roots and wood of
the rootstock. As the root vigor during the flooding treatment was positively correlated with root sugar content,
it was considered that the decrease in root vigor due to flooding was not only caused by oxygen deficiency but

also by the decreased supply of photoassimilates from the scion.

Keywords : Chlorophyll fluorescence, Defoliation, Tropical fruit, Water relation.
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HRET, INFECTHTTEOBEARIBEOAFICNIZ
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RVNWE b= ERPDR L, BAEBORKTSH S
EHE SN TS (KBS, 2000 ; Yano et al., 2002).
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Root system of the giant Cryptomeria japonica tree collapsed at Shinmei shrine in Okute town, Gifu, in July
2020. : Yasuhiro Hirano", Kazuki Nanko”, Ryuusei Dor”, Rei Nisuvura”, Tetsuya IRivama” and Toko TANIKawa”
("Graduate School of Environmental Studies, Nagoya University, 2)Department of Disaster Prevention,
Meteorology and Hydrology, Forestry and Forest Products Research Institute, *’Graduate School of
Bioagricultural Sciences, Nagoya University)

Abstract : On the night of July 11, 2020, the giant Cryptomeria japonica tree collapsed during the heavy rainfall
event in Okute Town, Gifu. The purpose of this study is to clarify the characteristics of the root system of the
fallen tree together with the weather conditions such as heavy rainfall at the time. In July 2020, there were few
sunshine hours which could induce higher water contents of the tree and soils. A large area of decay was
observed in the root system close to the center of the stem and roots remaining in the soil showed signs of
stripping. Using a laser scanner, the three-dimensional structure of the tree was digitally reproduced, and the
volume of root system was estimated to be 43.2 m”. The diameter of the rootsoil plate and the volume ratio to
the aboveground part suggested that the root system of the tree was relatively small compared with those of
other C. japonica trees. Based on the evaluation of the root system and weather conditions, the soil
reinforcement by roots could be reduced due to decay during the long-term growth periods, and the balance
between the above- and below-ground parts of the tree might be disrupted by the increase in the water contents
of the tree and soils caused by prolonged rainfall and lack of sunlight.

Keywords : Disaster, Root anchorage, Root depth, Root soil plate, The Heavy Rain Event of July 2020.
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2020 4F 7 A 11 H O KBEREGEIL, JEVHET 9.7 m
SR ITH A9 ICReER L7z (5513 ce). Foni2:8
M DI R IR JEGE O e K AE 1%, PERETE)A T 189 ms™!
ZTHS8SHTH2L 5 ICREL TWwab, 2010 E2 5
2019 40 10 412 BT 2 e K i B O 4 5o Kl 1,
T/NDAET 2014 4E 10 A1k SN2 172 ms ), &%
KOET20174E9 HD 252ms ' ThH o7z
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1R IEREIKITERE ) AMeDAS Bl H S OFEIRIZ BT 5 2020 4£ 7 A OKRBIHME () Bk, (b) HEEER, (o) HH
LEFOBE & O GREIT 2021a & D5 F 72135,

KA BMEE 2020/7 @BEME  BIMEHH W2 O B i BUIMEHH

(a) Pk 7 P B K AE

H Bk (mm day ") 137* 2020/7/11 143 1994/7/19

e KRR R (mmh ™) 43* 2020/7/11 45.5 2012/7/19

7 R 2 AT

i 2 B kR (mm 2 weeks ™) 486%* 2020/6/28-7/11 124 2010-2019 4E > 7 H 2 JARY
(b) H HEIFER 7 H 10 4RI 1H

H H IR (h month ™) 70.5%%% 2020/7 186 2010-2019 £ 7 A

11 H B HEEREE (h 11 days ™) 14.7 2020/7/1-7/11 (o 2010-2019 40 7 A 11 HH

(c) E# () 10 4B DAED H fp Al s

H 5 R RHE (ms™) 9.7 (4b¥) 2020/7/11 KAE 25.2 (FITH) 2017/9/17
Hii 2 R O RBE R RE (ms™)  18.9 (FHRE4TH) 2020/7/8 fi/NE 17.2 (FETE) 2014/10/14

#1976 SELIR D 7 B O & BB L 2 7.
#1989 4F 9 F 12 H i A 195 mm B 2 # [ 482 mm DFLsEdH 1) .
1999 4 6 J3 12 H#% Ak 153 mm OFi 2 3/ 452 mm DLdEdH ) .

#0010 4E LI > H H FE B AL,
##4%2010-2019 4 7 H O HF3ME 186 h 2> 5 11 H 1245

s 1 I K ) JEGR O AR RIS D W, i85 10 B O FRAE & FMEDTE.

2. IR LE=REDIRR

(1) #b EERIRR

BIARAL L 72 KA OMRIT ) & TR ORI E £ T
BEL, 198 m (552 Xa), BYIWIEmD S EAR T A
BRI EE coBEIE, 223 mTHY, KO
Bk 421 m EEH SN (2 %), KBoE
BT 2.7m, BEHEIZ101m TH o7 (2 b, ¢)
L= —lECHS SN Sl ET— 21280, BRIt
L7 K OBAT L 72O A HBT 5 2 L3 TE 72
(83Me #5Ka). L—HF—lllEsNn-BETD
BT — 7 2FHL, FONEEEREE LTRITSS
TS /1A 10 cm BFRCHEI LIME L72& 25, RIT
A I (LFERHAA S5 8E 19.8 m) F TORME
fEiE, FHEEEAESDbET1402m® o7 (B2
Fb, £5Kb, ¢ d). SHIIHELLBITHILOH
S L OBRNS, Mgk EACGE L7os, BYIRm L D
b FEBTEG 72 & o AR, 182 m® L EE & s
FThbBEIARE L /2B S CRARA L Tz Eigg s
BEIRE M EERARE 1L, 1584 m° & RAED Sz,

(2) HhTERKR

BRI L 72 KA Ok FIgEEE, HhmB L0
BEHBIZOWT50m, 58m Thorz. WSV %k
Mg L L7zk:, FERAHCHEL Cwielz &oizeh
FhoRAMIZ, #66m HIImOKESTHo
7o (552 %b, #3Xa, b). PRI O % FERE A
POBIET L L, HOBERS TH L HEF LI T
JEFDHEA TV (3 Mb). Fowofbfixs Bb
NAZEBPLEBIETEX, CoBhuLATES L LM

RIZIEFTNC & 2 22 LA HERR S 7z, sk —EBIL,
BIRL 72 MOHERIEE > TV E 720, Foigh
L HARSROMEH MO EEEEIE 31 m &, fEH O
THEE1IIMm I B 12miTEREDR-72 (531K
bl). F72EFI D& % FH ORI EEIL 3.3 m,
RAKBEEITZ47m THo 72 EIMD2). REEDE ST,
/N04m A HIK 23 m & BEIAR(L L 7-ARERD L EBH
TEL LD, FHTIE16m THo7z (3K, d).
L= —ERF I RIEITE i S NB B X ZHEA
DHT, ZOWRIIET V& ML E KK O = R TeH
ELTCHB SN (E3Xe, #£5Ka). IhHOM
HHOEHET— 7 W, #EEHEFEBICER SR
TAMRARE L 432 m® TH o 72, KIS ORIIHT AR
SORREIIE, 0273 o7z (552 F0).
FAZBIARRE (ZFFBE AT O 13812 5% S Ui 1o @& L
ToEES em PLEDORIX 22 RIS SNz (B4, 5
6, 7). INOLOWOAELE EALRL L,
BIARF ORI OIHKMNZ D 5 HE T % EVAFFE L T
T2 HEM SN BMOPFRAT LTz GE4 K, 56X a).
FMOMEIZOWT, FEOMERZ 0 & L7zFED
RSBNCRA & RBRIZKAZ QAL FMNAFAE L 724128,
HERODLWERMPOERS 2mBEF TEFTL TS
D, FHEARICELSTI E B XN T IR N
((B4e, % 6XDb). FRAFL72MORKELEIL 79 cm
Thotz. BIREOKEOMEEMNIAE L Tz L
WENHRIE, BLHRV o0, KELLBOES)
LYW s L ) B TH-72 (4K c, d). ¥
IZTEE 58 cm D N— N RIOYIIE % L 728 122w T
(B4 b), HEIRVTSNZBOBRRMD ZD
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25 KBTS EIARD (a) #1358, (b) #NE,

(c) WA L#TDI, (d) HIEOIRMK.

w%

(a) KASEIARH L 5F
HESERTE (m)

YT £ COME (m)

FELN I 2 & BRI i 18 £ OB (m)

4 mE A (DBH) (m)

g B R (m)

HEEH AR (m®)
WU F T ORBARRE (m®)
LA & ) _EESRoRERE (m?)

42.1 Y o _F T EE o s E

198 #2M (a)

22.3

2.7 #H2b) (o)

101 %521 (b)

158.4  ERUIINTIE O L T ¥ RFE O s E

1402 L ——{llE* L HEHE

182 L —H—{llE* OB EELHEID
BtRa 0 & B & 8 & ARGE L e

(b) KAZEIAM T EL

ek HEH S ERE (m)
e MR RIEAE (m)
e LA (m)
e A (m)
WA S EE (m)
A MHRKEE (m)
HET7 S F I (m)
T3 RS e KIEAE (m)
SFHEE (m)
RAES (#E) (m)
I/NEE (m)

HEERRAAE (m®)

50 530 (a)

66 30 (a)

31 3 (bl)
1.9 % 3 (bl)
58  #3X (b2)
9.1 #5314 (b2)
33 3K (h2)
47 314 (b2)
1.6 %3 (c) (@
23 H3 (o) (@
04  #30 () (d
43.2 L —H—illsE* LY FHE

(c) RBBIAR A% AL (m' m ™)

0273 L —HF—illsE* X hEHHE

(d) t3

IR FE L2 EE 5 em UL EORE ()

pH (H,0) % & 20-30 cm
% 80-90 cm
% & 120-130 cm

22 B4, 556
4.64
459
4.61

#L—F—IED A 2020 49 H 15 H. ZOMoMl%EIX 2020 47 A 22 H.

CIWTT SRR S L (B8 7 X)), 2 YT IH] ] oD 1A e
13427 ecm Th o7z, FBA LRI BEHST T
PO S N s s e w 2 Y B TSN R (A
TEEIZFRAT L 72AR 2 05 L 72 B ISHRAL L 723 & 20-
30 cm, 80-90 cm, 120-130 cm @13 pH (H,0) %, %
NZIN4.64, 459, 461 L, FEZIHEDLLTVING
B cho7- (552K d).

EE

1. [RERLEIKRIE

FKIT AR O KA 1L, 20204E 7 A 11 B, %
o, BEARLLZ ZOBERE L TUIL S KO
EMRBS Lo EAHHE, 2020 ; 5 HHEH,
2020), RHRER L ORI O W TR THITR
ENTwiv, BHOKWIZEN & HEN 2R T,
THEAS A2 7 AZEW EBHEOT 5N EW
B e, B HET 2 M Tl 20 4E B OFEIGERK

#1817 mmyear ' D 453D 1Ll EORKEE L 72,
—hT, KM ZD L) %ZM% 7 1213 1994 4EI12,
oo A % &5 111X 1989 4F 9 A 12 H 7§ & 195 mm
day™', ZFILLLET 2 B 482 mm 2 weeks ™! 7 &, A

CEH T T4 FDIATH 2B A L TWwb (51
F, ORJLT, 2020). vhbL, SHOBEKEIZE
O 670 FEOAFIAM % ZE 5 UL VR T
X7 L72As> T, SRS O AP EIARILOERE
LI TERNTHA ).

C D4 2 4E 7 AZMOMIHIT, 2010 4205 DFLHE
TdH DD MERARME % 7R L 72K KRS H R 255
5. 2020467 H1HAS 11 H F T H BERNILBI4E
OO 2EHBETHL (1R [T, 2020). =
Nz L oWEmoBKkENDS S LREATELET S
&, BAKREDZWARED fi < 7217 T2 < HHERFERH A
DI T TIERBHADSHE: L e v, FRIC B3RO
T- 72IRREF 72 P ARAZIZ B2 5  fid T ke



SEE S M OWEFE (Root Research) 30 (3)

1 65— 75 (2021)

THh,

O LY RRPRMM TS > 72 2 L%

BANL v/ :\’* (Chamaecyparis obtusa) TIIIREKE

TR
DIHH 5 2212

BT L EBEPIEIUIME TS 52 &
s i”L“Cb\ % (Kamimura et al., 2012). AHFZ2

1t (a) R RIDRD FEimEART X-YEEARALE

400 (EABRT=E) R
— &
£ 300 . =)
& ,S%Q‘EL
B 200
&
100 E'KT
7 ) — B4 lw .Blﬁ B12
33% 3 141000
-100 1
BI7B1 '320
-200
»sooT'ﬁ—

100

50

(b) P RIDR D K IHERTDFERE
(1o R7=E)

maE  1EEX IR BB (on)
E 0- i = Q0 400 .iG:) 800 1(X)Cli
s ‘ B4-1 88 o
P (]
22 A AT
i@ & 100 o3 & B11
B7
E U B2 Bl B16 8.1% N0
Q Bk 150 3
uﬂé
W 200
-250
%6 P B TOTEIEA LS L2EES5om LR

DRZORIZOWT (a) b A5 R fE e
(b) M & OAriE X,

ESITEBRMER 2 S OES. BoKS IO
BB, WAL 22 AR72H5 1 ARALE R E T
A2 iE 21 AFE#L. Bl ~ B21 B0 EEK 5.

e W

RO OS2 EIETE DS,
ﬂTKu®mé%i%mﬁ§®%éa
—D L LTEBITREDD LA\,

— AN AROBALER D —> & L THar s T
51 % (Hale et al., 2012). 2018 4 8 H O HJH, 21 512
LG OAFOBALTIE, FEY b L ATHE
DA R BMIMEAPERE L THEEINTWS
(Tanikawa et al., 2021). 7580 B {12 58U R T
B o 7273, DT BRI DU BRI TR 22 L,
A0, HHRT Tl i KO GE I JRGE AR ER S 1,
% { OAF ORI 25 H# %O B FFHY TH -
7z (Tanikawa et al., 2021). 2020 4£ 7 A 11 H ® 3 H i

’7@; IFA 189 m s ' DA E ZIF T Wiz, ZDfk
WZJRUA %2 25 2 CAEPE A 5 9.7 m s~ O RRJE % Bl A
1[:0)1"3 5 KEHIATICZ T Tz, — T, TS DK
w‘iﬂﬁci;_%&kt@c L CHERNC IR b LT Tld e oo
. REFZE Tl R E o 2 e M 2 L O B % BER O
~otLT%@Lt%@@,$%ﬁfi&H;bt
JAZLTH D2 e, BIRMLOERE LTI 0
BIIBITONLZWTHH ).

7 HSENR O
BIARILERN D

2. KEDORRIKR

BRI L 72 KA2 1%, BEFIICRK 9.1 m, HEJTIANIC
&K 6.6mOERE, RAES 23m % b OE KRk
ZHEICEDIZL: 1K b). T E TIZHBIAD
HOE Y L7-BRoektEicid, WeiEe (DBH) &
OVEIEEARSNTBY, BIZIET TV AIAH
>3 a7 (Pinus pinaster) OERF-EE1Z DBH & 2.2 45
L E T4 (Danjon et al., 2005). FAVEH S TH
JRDFREN & ) BIARIL L 72 A 7 IR OREEOE L &

7 EIAMCRI O (FAEA) & HIRICERAE L 22Ul (B LAY,

T T I R A GRA) 1 427 em. (a) AR OV
% 5K a) & UN— b EIOAR MY

7 L 7R ek (B1,

g sy, (b, o) IR
(2020 4F 9 A 16 H i



SEE S MRORF%E (Root Research) 30 (3) : 65— 75 (2021)

FEEIZE L CY DBH & ORI HESNTBY
(Tanikawa et al., 2021), = ®X 2 KkA%0 DBH 2.7 m %
HTIEDDE, WEEOEFIT24m I, EXiE32m
&%, A (2015) T3 124 F T A DBH 48
cm DAFOMRITHRA 34 m OFE S IZHE L2 L HiE
LCw5. 7 Karizumi (1974) 1&, 29 #1281 5
DBH 5.2 cm 7*5 36.9 cm O#iFHD A FC, OIS
EMRAT33m Ltk L T 5.

ZDL) BAFMRARZNL D ECIREKOE X)L
WY EEETLHE, WINOBEH (Karziumi, 1974; #if
{, 2015 ; Tanikawa etal., 2021) &, ZOFAERIRAK
DX HIZERTIZZR V720 bl 2 iid i LS,
WEHOKRESHPLHEESINLMHEORETS LD B,
FKIDOREDNES N L IZHLE 2 TH S, ZORRHI,
L —H— 2% ¥ S TE=RITEESHE S M BIROH
B HTERRIE CO RA S EASTE L, AF I3
FEPEE L€, ARLRENCHEHERE SEE 50 1SRRI
BT CEE, 2020). 207z, 7 a <Y (Pius
thunbergii) R° 7 /1< (Pinus densiflora) ® X 9 |Z1HIR
EREESELZEIERVD, FOoTHICHBLEES
HDHI LT, WREBMEL. RSO IHIR
FEE SN, FEHBIEED T RIS
% LTz, BuLfhE o MR OB o2
5, 600 ELL L B b2 2 kB0 EF & &I,
B O OMRIZE B X OO RIER %22 TiHE L
B X AMAINARDTRE L7245, BIAREORAD L
IBRIEMNNIZ o720 D LRI NL. WOFESHN
I22WT, KO DBH Ok & & 2 ZETIUSRED
JESSEAPZT TR, i L7 HIERmICHEL L7
MRS 22 R E A7 <, BRI O TIEFICEHD T
WHELTWboo, HEIHMNINE L7HRIEIE
EAERD SN pro T,

L == 2% v FIED S B SN2 KB ORARME
k432 m’ LY, SRR ISR 2 ARR IR O i
0273 TH o 72H, ZHIFAFOHTHR/ #b - HE &=
1 0.26 (Fukuda et al.,, 2003) X255 A F 29 #5512 B 1T
51t 0.29 (Karizumi, 1974) [23EWVETH - 72, K20
W EEARICIIHENE TN T ST, ERILTHREE
EHh EE O 24% % L 34 & (Karizumi, 1974), 52
B RAZ O T E /B HIL 023 F TIR M5 5
722004 4E 5 H 2V FIC X A1 % 50T B LR o
BRI 60 m LR E STV (GRKET, 2020). Zh
LOZ LI, AFL L TREORADM FEII LT
INEWZ LR THETALDOTH L. T RKITAEIA
b L 72 KA ORERD & T2 P i L7, € Ok
25 OF KD TN @Y g EHASHTE/l L%
FEFELTWAD., Tz &, @ OBAKTIZEENIH
WAL Z E DT E A E WD, FERERIZ K0

WIZitLAA M EEER A M4 2 & ¢, B

EHTHOER/NT A% —HEICE LS g2 8 b
HRIND., FHNL @ L7 NAKIIRSMEO+
AR s, KGR RO L CEIKIEIT %
TSN LH 5.

FERERT O HFRIH A0 5 F3E L 7o LI 2R AT L I
WCEH L2 S em LEDOIRIZ 22 R TH - 72 B
FAZRFR OB VEHTIEEALHM & it L TRWIRDOFAS
Bipdnodz. TIUTKEOBEMISEKDSH ) Z5
SENCRKOWIEDRETE o722 &, KigdLHMl
B OMWERIC LD ARENH ), FO TR
EELTWZ e RSN FA-hI5RA L
7oRRIE, = AR LZAROYIME ISR S NS L9
12, IS OROYIMTHOBEE S, &Ik
V) XD BT LA RIOBEIRIRECHR L7 L RSN
LIEEERL T, FREAE L7720 OPORIZD
JEFIHHEA TV B ET D HERR S, RO Wi & IR
D E WA (Yamase et al., 2019) O 753
g2ah.

3. FEDHITMAT
BARODBEIAMERE LT, ZOIREFRH LB
DU B B REFGEC BT B EIAR KA O AR A
5, EHE L TREOH LIS 2 T HRADA
BOEHS, REOEFIMN) LHKGEREIEE
BRI ORATRIE EN S, FRE LT, #
RERTOEINZ 72255/ & HIEA I X B Kisiik
WO BRI BT A Km0, TIEKSEOBE
WZPE) IR TR O T AR SN L. TS 2 GEE
T5H720121F, 5% HRAE L OTERAE, 5
VL SND. FRROBFIRIER & 5 7 2 BRIKDI
DFFMZ &I, M KEB L OB ARE OB
V=L L (REHS, 2021 FHRES, 2021 &=
55, 2021) OWNED, SHRFEMICHRESINLTET
H5b.
ENOFTFMIZ D L CHEET HEARR, HFHIZBW
TREAR L7 EoBIALI, TEOTEED
IR, SR ETEITHEHITRETH D, RIFETIL,
BIRDOHRIZHD T 3KICL —F— A F v F{llE % #
AL, BIARboRN A% S ERRE & bR T
BT 5 Z LTI L7z, SRS E N 3k T
FNT—F%, REOBEARLOLE Rt E TR,
S Ptk 4 72 HIH ORI S S IZFEM 72 f#AT & W HE &
RAHREEFD. RFE0 L 2, BIARLL R %E
ML E LTI L, Mer REIRLOZERN %
ZETHEMMA L LCERT LI LA, BRI
THMKOBIENPL S, SH—BEEL L THH ).
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AWFFEIE, MDY Y RVBZD L) e KEREES
F2ERIZS b5, FARIC B E il % 70
TW272 &, KFIFIZOWTITHRAEB L O T
TENT2RKMKIT B & OB KA AR RS 3R DB AR L0
PO AV LET. RRE L KHITOFEZ LT
AVAVAIRVAR i =y G2 e B S AR B P S €5
AN TTRIE % W 2 75 o RS AR ZE R o0 B
FHBE T, IR IR R 0 24 TE B RIS R 72 L
T ARLEEFHL TR0 HIEERE R IR
BaWiz72&, HH)PL)TEIFE LA KWFEO—
O, BHFER (20H03028, 20H03024) DBy 51} 72
LDTH5.
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HEMHEEOERERANESE 3. RiE—

BAEs Y - EHRRY - BAIRY - liRssrt?
1) ERKE RBEEDHREWER

2) BHBIXRFEMERFER

3) EMIBRILEEMR L2 —

4) ZEEXRFEYEERARMNAREE 2 —

5) BIFRATIREEE - S EHT

E B RoRBEIIER S L BARMRIE, EAKTEICB VTR L it i EE & M R ANE 5
MR O 7% CEABEOMY) BE R L2, HYOMRECET S AHEELLETHS. —J7, RETH
FIZA SN DN MR S FARO&E 2 ) Z EPHONTWD, AEEE I REHBLOE2HET
F L 72 Z2BR R 0 WlE JiiEL, @S0k & AR 2 486 LGRS 2 TETH 2. —77, WREIIRD
HEWTEI T O WIE Z fEAT S 2 7200, AR & M RFR 2 85I CFHET & 5. AT, MSCTIZEARIC
REND Z ED R EEDOFNITEICOWTREL SRS 5.

F—T— K EREAT, AR, R, SRR ke

Measurement of plant tissue porosity: IIl. Cross-section method : Yasuyuki Nomura”, Katsuhiro SHIONO”, Satoshi
SumMamura” and Takaki Yamauctr ™ (VResearch Institute for Food and Agriculture, Ryukoku University,
“Faculty of Bioscience and Biotechnology, Fukui Prefectural University, * Tohoku Agricultural Research Center,
NARO, ?Bioscience and Biotechnology Center, Nagoya University, YPRESTO, Japan Science and Technology

Agency)

Keywords : Aerenchyma, Cross section, Image analysis, Intercellular space, Methodology.

1. FL®IC

B OMWDZERRIL, Hb FFEA SREEEANOIEFE O
RAHFG T 5720, MY OMHEEDTRES & HH (2B
LCTwh. RozZEpiE, EIZHEBROKS 2l sui s
NI S NS (BR S, 2021 %5 2 (2
M), MokkEx s M, RESH D2 H
9 AAE & ARTREWEHIICH 5720, FETIE
VRIS R & {2 2 (B 5, 2021 45 2
ZH) . RoOMEMY 2854 5 &, @5k & [k
WA REIRR & KR T2 3N T b2 s, BED
AR HBRAMRIZ BT 2 WFE OB —EDERLE LT
W ZEDbhh. —, WSHRRII R EE o R
R EBE O RIZE > TRELEET LD
(Jackson and Armstrong, 1999), N HifaRIFR L ) &
MEOWRICKECEMT 2 EE2 6N 5. EFFIZ,
Watks L ORI D 5 BRMEO R OE & TR
SN BEAMIE L, A % ORI B Vv
TILFR Ny EO Y3 EOIRGRERY & L TE
WME[AIZd A (Yamauchi et al., 2019). ST E0H b,
WEALIR Z A1 L 7A@ AT O iR~ O G 12

Tkl e Bele T L R BEVMDLZ ENTE S,
AEIOFE 1 EH &2 [ HTHY FIF7-2=2BED
WETE (BFS, 2021 =T 56, 2021) &, HRIZE
¥ %l AR & AR BR O A & FHIS 5 T TdH
L. FD0, ITNHLOFETIIZEROBRFICK TS
WSRO TS 25§25 2 L IETE RV, KFE
T, ROBEMY A OWGE T+ 52 £ T, RISE
b AR & B RRR O E & 2 MBI FHEis 5 2 &
MNTE DY FEIZOWTERITBLMBEE R E LT
L7z,

2. 1A%

(1) 1EHTEN H D/ES & B IS

HEWTE) R ORI I 28R, 22128 b mWEBhr (36
) BN I IV ) TYRIL, FoKREMZLE
= HNF 2= TEIZEYL L C, WEREZER Y 7T
105D EE L THRAT 5. 208, Sz miaiH
BUZIZEARDTE D 720, KD L e WRREEIZ T
ELMRERE L CRBEERZEICMY RS2 B
o35,

REWISD Fr OFER 21, HOZERALA S 5 mm FEED

202154 A 9B+ 202146 A308%H

*EHRSE T 464-8601 EHBZHEMFERXRATEHRT E-mail: atkyama@agr.nagoya-u.ac.jp
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F1 A A OAREROFWTE 6.
(A) BN S NI R, B IENI R MO BN X I S Wzl Sz R 3. (B) EA Y
Fr. (C) IEADH M. (D) LA REETRIAHTE - R . A& ORI ER L E - 2R %E R,

WiR 280 LTS 5. 20k, LEOKERT

L72ASA K75 ALETYE vy bEHWTHEELL:
WRoOWR %7 IV ) TYMT 5. AR L7214 20
ROBEZ BRI oD VIEIE 7 2 F— o jRr#E
SO N AR, R VRO &A1 7
F—WOAT VLV ADOWMHAEZ BEIDT 5. £/, HY
LB 2R S WU R 2 E RS 23561
1, WEAIEEICHEC o T A 2 EREXTIZIEL 2o
TWHZEDdb. HFURELEHT 2 &l
PR A E, R~ v — BEERSE TRl L T8
FI4 VPR EIZ AN =L Lo THEET LI LD
WHETH B7%, [EEDBRIRO WS ZL§ 5 2%
NHH 572088 Lk, —7F, HERERLWD 7
b3z b—24 (MTH-1) &, EAZ IR % Phis
CETCHIBAEET D I L —EDE LR
RVEET L LN TEL, HEREREHD A — 2 _—
DT, FHLWHEHAFEDAHIN TV L08R
1172\ (URL: https:/www.nihonika.co.jp/product/846.html) .

EFURFEEHNTH S —T, 100-200 wm FEE
DIEHTLE L7z 28 2 7201 2 E B 19 22 31
RS VEE T 5. WYNAFR L 72RoBER A (551
M A) LT, EAZYR GE1HB) 2, 7HEWY)
B (51 C) TIEIMROEIRR 2B O & 2SR T
Y, FHBEOERBOUESNETH L. F72, #Y)
YR E2ER L7236 TH, FOLon) LKA sh
TWARWEAIZELIRDIIRT LI, Eo &Mk
PHRLE S 2 L TIEER ZZROTRBEANETE 2w
EWBHAH. TOL)BRGEIE, ATA NTIALED
KD HIZ Y & TR 22 R 7 O
T50, LEDIPS%TY ) —VEHFLTERY
TAVTTHIE TR REAERETE S,

VESL L 72AROREI O B O 121, BB Rl o8
WA VD, EREMECTH-> TOEMBHTE 2
bOTHIUIHER Y OWFICHEHAT 22 LB TE
L. WEOBIL, HN—7 T A EHTDH T L CTHEkD

RIZH—ICEE2EbE NS, HORIEIEF IS
NGz, Erty METEZ LWL )&
HIN—=T 5 A %P5 EEET L. TV VTG
FEHTCIXE 7 EVED S EBEO A X% MH T 57
O, BHOEED A r — V% & AR % BT RO
{5 & 6] DR & R CRUS L CB BN D 5.

(2) ERETIC K HIROEHBOEBENES

3 V¥ a—F X RN AR T X 2o 725
iz, WRoOBWOI R Z8ae L-miigeB% L, kL
TEEAERREE 15 L 7S S @A
FITYDIRATES ZUE L THELTFET LT
(Armstrong, 1971; Atwell et al., 1988; Kawai et al., 1998) .
WS O~ 7 N = 7 AR ISR T &
HEHT otz biE, WA TIZLDE LR
RS P OMFFE 2 RWICHER S TE 72,

Image] 1%, >KEE S #FAMFZERT (National Institute of
Health; NIH) THI% S /24— 7 0 v — A OB ENT
V7 b 27 Tdhb (Schneider et al., 2012). Windows
& Mac O TS5 Z & HCTE, NIH OB
A4 + (URL: https://imagej.nih.gov/ij/download.html) 7> 5
Frou— RuRETH A, F7-, Image] ([ZAEWMIED
FENTICE R 7T 74 V& FOERL 728y or— D98
Fiji (Fiji is just image]) T& 4 (Schindelin et al., 2012).
R SR~ OIS S HAEZ, T Fji %A1 +
(URL: https:/imagejnet/Fiji) 7> 5 %7 > — FL T
Image] #FIH 9 5 Z & 2 BEIOT 5. HTFIIZLLT
DY TH 5.

[FIE 1] 27— )V D5EF : Fiji @ [File > Open] 75
BEHIDE S DA — VHS A - 72 HfG & 8] L
THI <. Fiji ®Y — V83— 5 Straight 7 —
WEFIRL TR — LV EABEOE S OMET]
< (%5 2[X A). [Analyze > Measure] % 3
W5 EHE2XB DL I Results DHIZE

- 77 —
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O

olc|ol <[5 N Al ™|

(Fiji Is Just) ImageJ

Stk

wlofs]al |>

Scale_imm.jpg (75%)

780x780 pixels; RGB; 2.3MB

52 Image] V7 b7 =7 CO AT —IVORE.

1 752

Results

[Mean Min [Max
163.912 160.333 167.667

751

le

Cre Set Scale

Distance in pixels: 751
Known distance: 1.00
Pixel aspect ratio: 1.0

Unit of length: unit
Click to Remove Scale
Global
Scale: 751 pixels/unit

Help Cancel OK

(A) Straight Y — VCHEHORSOATr —)VEFLESO{ET]E, (B) Measure |2 & > TYE
JENVETRENDEEZFHIT %, (C) Set Scale THEHMDEE & ¥ 7 vV AEKET 5.

& (Length) "FR &N 5. 2D, [Analyze
> Set Scale] Z#IRTLHLEE2HCDEH I
Ry 7T v TIPFEREIND DT, Distance in
pixels |2 Length (4 [A] 1 751 pixel) O fH %,
Known distance (ZBEHIO A7 — VO E & (4
\liE1mm) % AJJL T Global l2F = v 7 %
ANz ETOK Z4M L CEEEZMLS. 20
& & Global 7 = v 7952 & TLUREDOMIE
AT —VORENTI EMANL. 2d, @
SRR D X 95 \ZTHE OB G 2 AR
W 2861%, FIEH1 240 L CHifiz ¢
7ENVEELTHRHIZEHTES.

[FE 2] AW G0 Jr D RGO WE « BEWTEI R o 1 15 % %

LT, 22TiE, B3R %
OREWTY) %2 B RS 5. Fiji O —)b/N—
5 Oval v — )b % # R L TRk o) i o A4
% P & [Analyze > Measure] % &R % (45
3MB). ZD& X Area |ZFR S NIENR
2fk (whole root = 0.744 mm®) DHFETH 5.
kRIS, FHEONHEB L OO Pl % B 4
[Analyze > Measure] % #3552 & THE
(cortex) & HLHE (stele) % & bt 72 T A&
(cortex + stele = 0.694 mm®) B & O H LA
(stele = 0.029 mm®) DHFEAFHH S LD (i
R1ZM). b O&EMBOIRITRE I
FEMIETIE 22\ a3, BEIIC/ER S Ay
YR T, BHIECHlE L - mE2 5 i oIz
WIZiH-> TlWE%E M L— A LBE Ok
BRE CEBLL 2720, Oval Y — Vv a FIH
L CH 2 80Ed 5 2 & 2 Blo T 5.

[FE 3] B AARR O R OB E : Fiji O — VX —2»

% Freehand vV — )V % E R L C 8 &M &
(aerenchyma) D% ML — A5 (53
A). ESHARI I BRI O AHE T 5 2
ETHLLZERTH 575, MLBEIZ5H S
FUISHERE S L, HERROMEEZ PR L TRz
WIS 2 A % #E % 1 9 (Jackson and
Armstrong, 1999). Z D 7:%, BT
MRS 2 A X 7o & Rz Rl o 14 L S HE
RSBl cFl EN T b 2 e 2B L
ThL—AFT2ZENZEFE L (BE3XA).
WHEOBLSMAME ML — 2 ¢ 5B, Shift
F—aMLRECEETED DL I L TRT
DOFEFOERDS WL 2D, £TH ML —2A
L 72IRAE T [Analyze > Measure] % #EiR-§
% Z & THlAAF DM (aerenchyma = 0.236
mm®) 2EHI S NG, ZCCIkHATEET
575, AR OMEICE L CIIHE 2 225
aniwv,

[FME 4] B SRR O R - RO E LRI R

ZRTRRICIE, RIS 2 @Ak O
OB G HDHRTRT I EDP—KNTH 5
(Colmer et al., 2006; Shiono et al., 2011; Gong et
al, 2019). %5 3 MOFERTIE, WM
T# 0.236 mm” / #RA KO 0.744 mm® X 100
=317% ¢ %D, A AORTILBESAME K
SLAEELTCVDLIEDDbYDL. —F, KB
EHOE D THRE I ISR AR R IC 5 7 5 728
(McDonald et al., 2002; Yamauchi et al., 2019),
Tili (5 O B AL B DR & il i 3 %
720I21E, BRI 2 BAGHRE O AR D E]
GEHEETLZELEOAMTHL. ZDORGE,
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(Fiji Is Just) ImageJ

mifelf=] - PAP NN I T

e~ ® = RiceRootjpg (G) (75%)
1.02x1.03 unit (768x774); RGB; 2.3MB

5&'|u1|"| .

Results

146118 13 255

A whole root

0.694 148.084 13 255 cortex + stele

i 88.860 13 255 stele
171.997 18 255 aerenchyma

83 Image] ¥V 7 b7 = 7 TORDKHME O HFE DO EE.

(A) B5HLME (ae; aerenchyma) (% Freehand Y — VZEFIHLChL— 2§ %, (B) 4
& (wh; whole root), FZJE (co; cortex) 3 & OSFLUME (st; stele) (& Oval »» — )V ZFIFH L
ThML—AF 5. Measure |Z & o Tl S 71T (Area) 2SHENYICFRE NS,

TR O TR 0.236 mm®/ (B2 + HuiiEo
[ % 0.694 mm® — .0 O [ 0.029 mm®)
X 100 = 355% D & ) IZEHET 5.
(W2 1) RONEERE $RR, KBS L OIS
HEND, ZokE BEICIEROMILE
OWNZAFAET B 4Bz R TR RER R LR g 12 43
Hah, WELEBORMNBE LTERSN
% (Lux et al, 2004). = OREGIE% BfFE L T
U, EBRO HIYIZH > THRE R0 B BERLEE,
Kz % K & XL CTHlo T & RIREIL 22\,
M IR DT 12D\ C b il S & AR
FETEHUNT LA TES. LaL, Mk
MR D T/ EWT A%\ % [Image
> Zoom] % ER L, W% LKL THENIT
LI e BEIOT L. F7o, HMBEHEERIZIEER
DT 70, BT & B A E U
IZBIR) ZEBEETHL. WA LI
MRAEREY BT B B e oL iE & A R
@ B 4% 12 2 v T I, Justin and Armstrong
(1987) 1L (2020) %SRS 72w,

(ffiJ2 2

~

(3) Image] VI bz 7IZ& D ZfEILERLEERD
HEHTE) 5 D F B SR EHR ARAT
KDY GO BEAMEEE EHEIC N L — AT 572
OISR eF B D, CORMER RIS 5720,
YR EG % bS5 (¥ 7 e olEie TEoBiE
TO LT WHET2) FEIFRESIR TS
(Maricle and Lee, 2002). —AHAGIZIERELEIZ RS 555,
TRRECEMESEL CHRARTFEICAETE S
TREMEDSH B 720, DFICFIHA R T 5. 2B, L
Wwo [FME3] % [FIEI] ICESHZ 5 2 & THlsHM
IO RETH 5.

[(FIE3] B4 IR L2 L 912, COFFEITEEMIL
DFGER DR 7 B (5 &\ THTEDSE DS, A
DH LY TIERF 2 B O R %
FHBIC ML AT EHNTED (554
A BlxZNnZNE1IKA CEHEUHEG
TH5). #4MB DHZMME % Freehand  —
WA & B FAESECTRAAN L 72 14 59264 pixel
THH, ZfE{LL TH S 72l 50571 pixel
(FE%D 853%) Tho72. FMEE LTI,
0% % B & [Image > Type> 8 bit] % 3R L
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Click here to search

(Fiji Is Just) Image) 2.0.0-rc-69/1.53c; Java 1.8.0_172 [64-bit];

1524x780 pixels; 8-bit; 1.1MB

-

-

@® O @ Histogramo...
value |count |

300x240 pixels; RGB; 281K
' 210 1328
| {211 1236
55.56% (212 1242
215 1213 1206
55 214 1209
215 |1164
Intermodes B&W 216 1114
I | 217 1135
Dark background Stack histogram 0 255 11218 1181
Don't reset range Count: 309732 Min: 16 219 1115
. I 220 1131
Auto Apply Reset Set List Copy Log Live 51 1111

%4 X Image] ¥V 7 b7z 7 TOMAMREO AR O H B 20 5E.
Type % 8 bit IZEHL L TZ L — A7 — )WL L 7z L CYIR W% % 8% L %55 Threshold % 7% 7€
LC2fEifbd 2. Fotk, EEMMELE E N5 5% Oval v — V5 CHi%E L C Histgram 75
List Z1ER L, BIfE %8 2 5 pixel 1 (count & L CTFIREN D) O 2 @AM OMEE L 5.

T V=R = VIZERT 5. Hit\T,
[Image > Adjust > Threshold] % iR L ¢
FORENDL Ry TT7 v 7N THEOBIEY
RET A ZOL X, BEMEESICLCHE
BOT VY 2 —2SHRICEH (2L Sh
LI ERFFLC, @M (=) 20
ORI A WHICSE T 5. 20k, B
MO E N LM% Oval V — IV TIREL,
[Analyze > Histgram] % #iR L CHK v 7
7 v 7O [List] I2FREN7-FEEL 2

LY (SENIHE 215 L) oh v
NEGET L, ZokE FRENLERIE
MELZHZEFICLCHEBIZ L 2 -85
D, EANTITAIIRTEIIIKZEE T LD
M ORI SN TWD, =B, b
VT N— ECRE gL, AR S
J7 & o0 HE B ASHAR 2 5 7 2 IR A& U 5
T ENTENR, MY OERICED ST
IEREIZ SIS % 0 E T & BT RS 5.

(Fif2 3) ARG TIEFRLR L 2023, sk &TlRo
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B UTETET L7280 Al s 5 2 R O AN ERR O B O s S R,
ST R (%)”
T AT R S 20 mm DAL B ESA S 50 mm DAL A5 10 mm O HAE
S Sl ISR BRI RS G SR
Triticum aestivum 2 5 F IR 0.0-0.7 8.4-16.7 0.9-8.4 17.6-23.3 44-142 211253
Zeamays N7ET I WM 0.0-03 0.7-14.6 0.0-3.1 17.4-30.9 02-0.6  27.4-40.3
Oryza sativa A S ki) 1.5-5.6 4.2-16.5 18.1-26.0  33.6-51.4 29.8-350  45.7-55.3

WAL B
L 7 RSO0 ST B e AT L 72
AR A 051 500 5 AR TR O A T

L 727K BHE T 9 H RIHEE: L 7=k 2 IS 4o B & US4 T8 512 7 HM3EE: L, 80-100 mm (215
R 2> & 50 mm OFALITAEROMREGES & HT O h B O & I2247- 5. F
TRL7z.

1 MyETI Y E A AO5GAIL Justin and Armstrong (1987) 126V, 3 4 F(d McDonald et al. (2001) (Z5E- 72.
2) : Yamauchi et al. (2019) 3 X UF Yamauchi et al. (2021a) % Higi & L 7z,

FRBOEEL LY —A V¥ =T 2 —RA
LTl HEN (semi-automated) (ZHIET S
VT NI TR VAR T I KED
Jonathan P Lynch i+ 5D 7 )b — 712 L - T
B ENTEBY (Burton et al.,, 2012), HHAD
£ b (URL: https:/plantscience.psu.edu/rese
arch/labs/roots/methods/computer/rootscan) T
BlEr =27 Ve EBICAREN TS D
TERENw. Fo, BEEEE R LT
4 HE) (full-automated) THRE D & ALFE O THIFE
ZWETHEMOME L EDOSN TS
(Yamauchi et al., 2021a) .

3. BXMBBHEEEDIHELEDER

RO SHFRO TR IR ), A A% E
DOIREREY O LRI Z IR R & R TR I/ S
W2 ERH SN T A (McDonald et al,, 2002). RV D
Whge s, A F ORI ELHBIZITREZ 25 TH 5
FEARE CIESE DL LT, BRI IR IR
FEMHBT LI EDIRENT WS (Yamauchi et al,
2019). —/C, KB OHEORMIIZIE L - F
T 7 OB H Y, HEITRE CFEL T AR
TECIE, IIFEPICEREZERS 2L TREZRL (it
W BT e TELEEZ SN D (Ugaet
al, 2008). FZJ@ v EOmEELO b L — K4 7,
B0 D 1K EIE T 5 S8k 7 A A FHE A REY)TE O
A S MEE ST\ % (Yamauchi et al., 2021b). #Z2
T | OIS L 72 IR AR & K T S L 72
AR T, KRS o 2 B5ARRRIE R EZE O fE)SF
THoTd, B OHOERFLATR & WiEAERY
TIERERIZ 5 2 BEHETE R TRE AR &
N TA &\ (Yamauchi et al,, 2021b). =i, &+
BECIIRAECIEL DI L B 2 kX 5
S5 LRI A A S TIPS L B A
FlBEOIAANEWZ L EDEETHL—H, K
JE 2 K& BES TR ICRIER & (B & G5

DVBED 7280 T D (Yamauchi et al,, 2021a). T
LDZ ENG, A UESMEIZRETH > TH oD
WEERTH 20 TH 5 M L > THROMHIL R
%5728, WEHERICEER 2 T 2 B2 IEH & oWt
FEOHME A L@ 25t E B2 #IRT 5 2 &8
KUITH5.

4. RENEY & IEREEYICH T DR OET BB RE

WEAARTE KR O IFAT T & N/ ME D241 % HIbT
FToH72005FE LT, RANY L IFREMY) OAE
RIZBU 2 B REE 9 5. RO
(0% b AR DG O F5 ARG 2> & b IS ) Ao TR
FERIZFEET 5720, BITRR E LROE R E S
DFENZ L o THEAPKE (7% % (Shiono et al., 2011;
Yamauchi et al., 2019). D720, Z Z TIXIEEHITF
H T B & R HIAT IS A T AR OB & L
T, EHSPYRECHITL/z2aaFE by Enay,
A 3 O WM EOMEE AT L2005 (5B 1
). INOOREIRT L H1C, BRAMRRIEEEIT
WOEZEMTREL BELR L, 22T, FLoTERSGM
IR 2 BT BEICIE, 851 £ O X 9 IHRHGEE,
B & O o 3 T o8] B R & f#T L 7- b
T, EREBREANERT L2 L2 B80T, 2B
TEMIIZBR & 38 & 7 Al 0 38 SHLRR T e & MEAER L
725413, McDonald et al. (2002) < Yamauchi et al.
(2021b) 7 Ea B SN,

5 &HHYIC

— RIS, K F 7RG TR AR O 3 5
AHFRTZ DS HZE [y, — T, FRBAEMY TH - T
b K F 723 S CiE AT R AR & C bk
AT5 GE1ER). TOX) %, BRI ZIFRENT
AN\ BHEE 12 A B B AR L, B
REEFSINTEY, GBS TRANY & IRTERM
WAl LTS N A RHEN AR L (XX S5
(Colmer and Voesenek, 2009). 2115 2 7 £ 7D @A
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HMRIERL, SO EBREAOMIG & RELL
IZHTHINELREELTBY, TN TN ELR L 2
ZRA A THEYICHTE &N T B (Yamauchi et al,
2018). LTI, BEMMBRIER A 15D & L 7RO R
BRI A ORI 720 Cld e <, MFEzER s
BREZMEICDFGT LI ENEHEHED TS
(Lynch, 2018; 2019). Z® & 9 IR 25, HOfFEE
FHTEE % xR & L 72 BB SE &S R ZE O M T 55
BisABET A LI TVWE. 22 TRML
PO EERER LT, kL Mo E ok
TN T W72 & 7w,

HEF

REROPEICH L CIE, BB REEERE (JST) &
EDUF [ 74 =)V FIZBT AP0 E GBS ORI
M 7z kAR B o 8l (R E S
JPMJPR17Q8) D 4E & =T 7>, F 7=, BAHEZ &1L
WEBOIETOREORME L 7 - 72RIFZEHEED
(R ] EINBHME SR O X W #FLE B L R 5.
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glumaepatula (IRGC105668)DHIFARDIEFENMBA A WD DMNEINTERD L IFERIMFSNIZD T, ARRO TR H
LEBITHRET 5. FERIZIL O. glumaepatula(RGC105668), LS L TA 1 (T65) Z iV Mz Rl Za W17 ARAH B LT AR
FE TR 30 HERHEK GEAGREE 5 cm) F3PEKSA CABTSE b O% V2. B CIIAEARSE - B R —RiE @IS, RO
HIFFE, 2017) |- KRR B A S T LR AL, WInRHIZO (ZEOfEYTL 7. SERL7-FER, IRGC105668 & T65 Lb12i%
A7 ARAE 2 Ve R L TR DM Z DN -T2, ZOZENS, HeD A TS HFARIEA R 8% 52 T2 E)oR
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RAFHML TE7=. UL, BFERORODE NS, FRIAELARDIERAE DO BRI KT T80, 2050 THME I ThHD.
ARRIEUZ, TT AHDOIF NIET 7Y%, T~ R CIE LT F8 E RF IR RO AR L2 AV TRy ML, 58
FHIEZ AR bBHET 2B, AM BEFEEEREX, 72 Rhizophagus irregularis RIMEFEX, R. clarus ROWEFEX A HE L. Bhbtk
26 H XU 40 HOM FE K O RO i, AROBIRT-IEBL, BHRIERCR, MUARTIIEL T2, BRI 40 H oty
ECHTEE CRBD B, FI BRI Lo CHftEED 72 OIRAFIIME FL7223, Wb R SRR bV oT-. —7,
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HEH_05
Equal reliance on rhizosphere effects among 55 woody species across three contrasting biomes
Lijuan Sun', Yuki Tsujii>*, Tianle Xu'#, Mengguang Han', Rui Li', Yunfeng Han', Dayong Gan', Biao Zhu"
(biaozhu@pku.edu.cn)
Peking University, Beijing, China, Macquarie University, Sydney, Australia, Kyushu University, Japan
Institute of Genetic and Developmental Biology, Chinese Academy of Sciences, Shijiazhuang, China

Rhizosphere effect (RE) is an interaction between plant and soil which not only affects soil carbon (C) and nutrient cycling but also plant
performance and community structure. Yet, whether plants share a common reliance on RE as an essential nutrient-acquisition strategy is less
known. We targeted 55 woody species from a temperate forest, a subtropical forest and a tropical common garden to testify the scaling exponent
for correlations of microbial decomposition activities between the corresponding rhizosphere and bulk soils. Here we show the microbial
decomposition activities had isometric correlations between bulk and corresponding rhizosphere soils, indicating an equal reliance of woody
plants on REs. We also found negative correlations between microbial decomposition in bulk soils with the corresponding REs. We proposed
anew push and pull model based on the trade-offs among RE and other nutrient-acquisition strategies which can bring nutrient-acquisition cost

and plant carbon economics spectrum together in the future.

HEH_06
HHEEBIOMIRIC L DT & =7 B L UHIRRRE R AR C L BUES NS D> ?
(PRRFAEL - /N B 2+ BERRACT- 1+ HEARZRAT 1 - A (EAST 1
BT 21 AR
(takumi.ito04(@gmail.com)

ARFFECIIBAMIMRIC LD IEHEIESESR (7 =T R L OMMIARESE3R) OIS 2 IO T D7-012, TRIGEE O EREY)
PRRHE AT, T 8 AT TR OSEEBRE BN ST RILEE ) T 10, SISV ERERFED 7~ b
TH=Y, WAL /LA D 4 B LTz, fRARHAC 7 >7- EE= MV HL, NHC & KNO A ST ZERAII TR
T 90 HyfHiEFE S, AU ITZRERFIEOIIE, SR T T L DR bDMIEAA T o7, BIAKIIZ LT v E=T fes
SEWIGHE LR RE AR SR 1S, SRR IR 0L T B =T REEERO TR oT. T B=T REERIIN T~
VMO BTELDE i< a7 — 5T, IBRRERRIIN T~, TH= Vb /%, AXD N leoT-. % HRTREIC 1T D
NG SHRAEE DO BIRCIY, 70 =T EEE 3 CHIIROD LR E L EOFBIBIR)S b —57C, HEiEaERIT iR mbn
otz ZOIHREEHIVREIZ I D8 IVEL B E LT, 7o' = T HELTERARED TN ORI DR W E L HNS. 4]
DWFFENSRIGb LT BRI HET CORFMA ST B =T HEZ A <IN, KBS H7- O\ ARD TR A 25 &
HCWe. LLEKD, ARG U X2 E O R TIEC TR EARD FEREF A B G5 SV D SIS 2D 2
LDDAT.
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HEg_07
HOTYEORKIRRRIZE T HEEEE
FERH AL, B ERRR o, P (RIS R, AR AR BAL ST, - BURRT)
(sakifi@shse.u-hyogo.ac.jp)
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